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Abstract 

 

 

 

The main aim of the project to develop a system automatic accident avoidance car 

using ultrasonic sensor. Whenever any obstacle is detected in running vehicle depends 

on distance automatically control the speed of vehicle. The ultrasonic sensor system 

continuously sends signals and monitors any car or other obstacles are in front of car. 

The distance up to which ultrasonic sensor can work may be up to 50 cm. When any 

obstacle or vehicle detected by ultrasonic sensor system it will send signal to the 

Arduino pro mini controller. After receiving this signal embedded board sends a 

signal to the motor to reduce the car speed automatically which can control car speed 

immediately. Vehicle is controlled automatically without any manual operation when 

the vehicle is at 50cm distance away from the front vehicle. When the car come closer 

to an obstacle then it will reduce its speed 50cm to 30cm distance, if obstacle don’t 

move in-front of the car then our vehicle will stop automatically. Many accidents at 

High-ways are taking place due to the close running of vehicles, all of sudden, if the 

in front vehicle driver reduces the speed or applied breaks, then it is quite difficult to 

the following vehicle driver to control his vehicle, resulting accident. To avoid this 

kind of accident, the warning system, which contains alarm and display system can 

arrange at rear side of each and every vehicle. 
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Chapter 1 

 

Introduction 

 

 

 

1.1 Introduction 

 

This Road accidents are a global tragedy with the everising trend. Today's world 

people are earning more money and buying more vehicles. People are transporting 

goods to places most of the time, and there are always people that need to get to 

places. Be it cars or two-wheelers, taxis, trucks, buses, etc, the number of vehicles on 

the road is increasing day by day. While this shows a good scale of development, it 

also means that there are higher chances of road accidents.[1] Almost every day, we 

come across the news of some accident on the television, radio, and the internet. Most 

people continue to neglect and ignore the dangers involved in their reckless driving 

and so, these accidents happen.  

There were 1.35 million road traffic deaths globally in 2016, with millions more 

sustaining serious injuries and living with long-term adverse health consequences [2] 

Recent past few years It has become a national problem. Road traffic accidents in 

Bangladesh are multi factorial. Rapid urbanization and motorization can be identified 

as vital factors leading to higher number of road traffic accidents. At least 7,855 

people were killed and 13,330 others injured in 5,516 road crashes across the country 

in 2019.It means more than 21 people lost their lives on roads each day. World Bank 

statistics says that annual fatality rate from road accidents are found to be 85.6 

fatalities per 10,000 vehicles [3].Traffic hazards and road accidents have increased the 

sufferings of people.  

One of the main reasons is the lack of emergency facilities available in our country. In 

most of the cases, when an accident occurs, relatives of that injured person get the 

news of his/her accident not in time and the emergency rescue teams reach late on the 

accident spot and the traffic in between the accident spot and hospital sometimes 

increase the chances of death of the victim. Tracing the accident spot is the major 

issue faced by emergency units. The guardian reported in 2016 that thirty five patients 

had died in the past five years due to the late arrival of the ambulance [4].  
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The main aim of the project is to develop a system automatic speed control of vehicle 

and accident avoidance using eye blink sensor and ultrasonic sensor. Whenever any 

obstacle is detected in a running vehicle it depends on distance and automatically 

controls the speed of the vehicle. The Objective of this project is to develop a system 

to keep the vehicle secure and protect it by the occupation of the intruders[5].  

 

1.2 Motivation 

 

Road accident is increasing day by day, the vehicle controlling system is digitized 

slowly. Many things have to be done manually in many vehicle controlling system. 

Even if we work on ways to reduce damage from various accidents in today's cars, it 

is not possible to reduce accidents. Road accidents are increasing day by day. Due to 

this, the death rate is increasing. In our daily life we have to get into the car. But no 

one knows when a sudden car accident will occur. So we got interested in making this 

system to solve this problem. Our system will automatically slow down when a 

vehicle comes within a certain distance. After that, if the car in front does not move, 

then this car will stop automatically. This will save many lives. We believe that our 

system will be a blessing for this era. 

 

1.3 Objective 

 

The objectives of this project are:  

a) To study about Construction and Performance Test of an Automatic 

Collision Avoidance Vehicle to Prevent Accident. 

b) To design and construct an Automatic Collision Avoidance Vehicle to 

Prevent Accident. 

c) To reduce human death rate in road accident. 

d) To test the performance of the system and work on it in future modification. 
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1.4 Organization of the Book 

 

 Chapter 1: Introduction. This chapter is all about background study, 

motivation, Objectives and thesis book organization. 

 

 Chapter 2: Literature Review- Here briefly describe about previous book 

review, Block diagram, Circuit Diagram, Components List and Summary of 

this chapter. 

 

 Chapter 3: Hardware and Software Analysis- This chapter is discussed 

about our project hardware and Software . Here we describe our hole 

instrument details. 

 

 Chapter 4: Methodology– Here briefly discuss about project methodology, 

working principle and our system overview. 

 

 Chapter 5: Result and Discussion– Here briefly discuss about project 

discussion, result analysis, advantages, application and our system overview. 

 

 Chapter 6: Conclusion – This chapter is all about our thesis future 

recommendation and this project conclusion. 
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Chapter 2 

 

Literature Review 

 

 

 

2.1 Introduction 

 

This chapter mainly reviews literature, reviews of various types of work and 

highlights the importance of Construction and Performance Test of an Automatic 

Collision Avoidance Vehicle to Prevent Accident  in such situations. 

 

2.2 Literature Review 

 

M F. Saaid, (2014) This paper represents the GPS and GSM to test the accuracy of 

the location that is send to the system through micro-controller.The hardware and 

program development is done by research and error as the controller does not interact 

with both module at the same time. The experiment is done in three set of tests so that 

the system accuracy can be determine when stationary and in motion on vehicle, 

output controlling to the system. The result of the test concludes that the system can 

provide standard GPS coordinate when requested via Short Message Service. The 

system can also be used to control an actuator [1]. 

 Arindam Mondal, (2015) This paper is con cured with the orbit tracking by multiple 

agents. The control scheme has three aspects connectivity assurance, collision 

avoidance, and formation. The concept of this has been used to acquire and maintain 

the desired formation pattern along with velocity .The proposed control pattern is 

further extended to the problem of target system. It includes the roundedness of 

control actions. The realization of proposed system is manifested through extensive 

simulations in 2D and 3D environments using 6 and 60 agents, respectively [2].  

 

Md. Shahinoor Mannan (2015) this paper presents a proxy approach towards picture 

and practise of GSM based remote device controller using SIM548C. By using GS to 

avoid the early developments of the system .The possible future transformation of 

long distance controller systems to choose GSM Module SIM548C including its 
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GPRS and GPS features. Brief picture of the developed prototype based on DTMF 

over GSM network is conferred. The extant applications of long distance controller 

systems are including but not limited to some respected places, thus the convention 

and practice of such systems to control and track moving objects. [3]   

Dr. P. A. Harsha Vardhini (2016) This paper presents an adequate practice of 

security system for the moving vehicles using SMS alert system. The system uses 

micro controller and the components used in the intended work are related with 

detecting the accident, saving the phone numbers, and sending the SMS. The major  

elemental is the Atmel micro controller AT89S52 which performs all the operations 

related to controlling. The security for the vehicles is detected by using vibration 

sensor. This detection is sent in the form of an SMS alert to mobile using GSM. The 

embedded system enclosed with the fundamental is fit inside the vehicle for accident 

detection. [4]   

Yufeng Lian (2016) This paper presents a control expedient for prolonged collision 

avoidance to improve the safety of four wheeler motor driven electric vehicles. The 

two major system in collision avoidance. It has safety between driving roads with an 

adhesive deficient in tire and road and the contribution is a new braking force based 

on constrained adorning braking strength extension. RCP and HIL simulation 

experiments are drifting out to manifest the effectiveness and affability in practise are 

elongated in CA system. [5]   

Amir Khajepour (2016) This paper is presented to maintain a collision free way for 

autonomous vehicles. In this path planning, a 3D virtual dangerous electric field is 

formulated as an increasing functions of the road and obstacle. The Multi-constrained 

Model Predictive Control problem are calculated the angle from the front steering to 

prevent the vehicle from a moving obstacle.The simulations are combined in the case 

where moving obstacles exist. The results show that the proposed path planning 

approach is effective for many driving scenarios and controller provides dynamic 

tracking performance and good movement-ability. [6] 

Joseph Funke(2016) This paper presents a new supremacy structure that includes 

path tracking, vehicle stabilization, and collision avoidance and mediates to 

conflicting objectives by specific collision avoidance.The system is enforced by using 
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model predictive and feedback controllers. It includes stabilization and collision 

avoidance. Experimental data from an autonomous vehicle demonstrate the controller 

safely driving at the vehicle’s handling limits and suddenly introduced in the middle 

of a turn it avoiding an obstacle. [7] 

Ping-Fan Ho (2017) This paper present a Wi-safe Compared to vision based and 

radar PCA systems, It has an advantage of Non Line of Sight and assist drivers in 

discovering pedestrians in NLOS and blind spots where the views of drivers are 

blocked by buildings, vehicles, or other obstacles. Wi-safe can save split seconds. 

Instead of using wireless access in vehicular environments dedicated short-range 

communications to protect pedestrians. The results show that Wi-safe can achieve and 

even exceed the PCA requirements. [8]   

Yucong Lin (2017) This paper was contrive to avoid collisions with moving obstacles, 

such as commercial aircraft and the safe operation of unmanned aerial vehicles. The 

exertion of sampling based path planning methods for a UAV to avoid collision with 

comical aircraft. The variations and utilization are along with collision prediction 

using reachable set. The methods are in software and hardware loop simulations and 

real fl-flight experiments. It generates collision free paths in real time for the different 

types of UAVs among moving obstacles, angles and speeds. [9] 

Maneuvers Scott Schnell (2017) This paper presents a combined driver model that 

will identify different individual driver behaviors. The driver model consists of a 

compensatory transfer function and an anticipatory component and is integrated with 

the design of the individual drivers desired path. The utility of the proposed model is 

stability to predict a drivers steering wheel. It is compared by two different drivers 

model parameter sets to the group average to show that each driver has a unique set of 

parameters. The model is validated by showing that its daily driving parameters differ 

from its predicted CA parameters. [10]   

Lorenzo Sabatini (2017) This paper for achieving complex dynamic behaviors in 

multi-robot systems. In this system partitioned into two subgroups are dependent and 

independent robots. Independent robots are used to control input and their motion. 

Dependent robots solve a tracking problem to defined fixed point trajectories. The 

control strategy is explicitly addresses the collision avoidance problem in a non 
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conflicting manner. The combination of these control actions allows the robots to 

execute in a safe way. And the proposed methodology is validated by means of 

simulations and experiments on real robots. [11]  

Milton Cesar Paes Santos(2017) This paper for unmanned aerial vehicle UAV 

navigation and positive potential function is designed to take into the movement of 

obstacles. Thus, the controller with potential function that the UAV moves close to 

zero to ensure safe navigation in dynamic and unknown environments. An indoor 

framework with just one RGB D sensor, which is a combination of a RGB camera 

with a depth sensor based on infrared light, was used to estimate the positions of the 

UAV and obstacles. Thus the experiment is carried out to simulate to run using a 

Parrot AR. [12] 

 

2.3 Block Diagram 

 

In our project we have set up a Construction and Performance Test of an Automatic 

Collision Avoidance Vehicle to Prevent Accident. In this circuit we have used one 

Arduino Pro Mini micro controller for master controller unit. Here we also use a 

Battery, ultrasonic sensor, Motor Driver, Gear Motor, LCD display etc. In this 

diagram we will show by block the individual parts.  

 

 

Figure 2.1: Block Diagram of  an Automatic Collision Avoidance Vehicle to 

Prevent Accident 
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2.4  Circuit Diagram  

 

The schematic diagram here is representing the electrical circuit and the components 

of the Automatic Collision Avoidance Vehicle to Prevent Accident. Here we 

connect equipment with smart wire connection.  

 

Figure 2.2: Schematic Diagram of  an Automatic Collision Avoidance Vehicle to 

Prevent Accident  

 

 

2.5 Components List 

 

Hardware Part: 

1. Arduino Nano 

2. Battery 

3. Motor Driver 

4. DC Gear Motor 

5. Ultrasonic Sensor 

6. Electronic Beep Buzzer 

7. Voltage Regulator 

8. Resistor 
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Software Part: 

1. Arduino IDE 

2. Proteus  

 

2.6 Summary 

 

The above discussion gives an idea about the  Construction and Performance Test 

of an Automatic Collision Avoidance Vehicle to Prevent Accident. All that work 

on robots has already been done here, and the results of their work, the use of 

Accident Avoidance  in the  situation are described in detail. From this we also got 

the direction of work of the project. 
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Chapter 3 

 

Hardware and Software Analysis 

 

 

 

3.1 Arduino Pro Mini 

 

The Arduino Pro Mini is a micro-controller board based on the ATmega168. It has 14 

digital input/output pins (of which 6 can be used as PWM outputs), 6 analog inputs, 

an on-board resonator, a reset button, and holes for mounting pin headers. A six pin 

header can be connected to an FTDI cable to provide USB power and communication 

to the board.  

 

 

 

 

 

 

 

Figure 3.1: Arduino Pro Mini 

Specification 

 Micro-controller ATmega168 

 Operating Voltage: 3.3V or 5V (depending on model) 

 Input Voltage: 3.35 -12 V (3.3V model) or 5 - 12 V (5V model) 

 Digital I/O Pins: 14 (of which 6 provide PWM output) 

 Analog Input Pins: 6 

 DC Current per I/O Pin: 40 mA 
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 Flash Memory: 16 KB (of which 2 KB used by boot loader) 

 SRAM: 1 KB 

 EEPROM: 512 bytes 

 Clock Speed: 8 MHz (3.3V model) or 16 MHz (5V model) 

 

Pin Out 

Each of the 14 digital pins on the Pro Mini can be used as an input or output, using 

pin Mode(), digital Write(), and digital Read() functions. They operate at 3.3 or 5 

volts (depending on the model). Each pin can provide or receive a maximum of 40 

mA and has an internal pull-up resistor (disconnected by default) of 20-50 kOhms. In 

addition, some pins have specialized functions: 

 Serial: 0 (RX) and 1 (TX). Used to receive (RX) and transmit (TX) TTL serial 

data. These pins are connected to the TX-0 and RX-1 pins of the six pin 

header. 

 External Interrupts: 2 and 3. These pins can be configured to trigger an 

interrupt on a low value, a rising or falling edge, or a change in value. See the 

attachInterrupt() function for details. 

 PWM: 3, 5, 6, 9, 10, and 11. Provide 8-bit PWM output with the analogWrite() 

function. 

 SPI: 10 (SS), 11 (MOSI), 12 (MISO), 13 (SCK). These pins support SPI 

communication, which, although provided by the underlying hardware, is not 

currently included in the Arduino language. 

 LED: 13. There is a built-in LED connected to digital pin 13. When the pin is 

HIGH value, the LED is on, when the pin is LOW, it's off. 

The Pro Mini has 6 analog inputs, each of which provide 10 bits of resolution 

(i.e. 1024 different values). Four of them are on the headers on the edge of the 

board; two (inputs 4 and 5) on holes in the interior of the board. The analog 
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inputs measure from ground to VCC. Additionally, some pins have specialized 

functionality: 

 I2C: 4 (SDA) and 5 (SCL). Support I2C (TWI) communication using the Wire 

library. 

There is another pin on the board: 

 Reset. Bring this line LOW to reset the micro controller. Typically used to add 

a reset button to shields which block the one on the board. 

See also the mapping between Arduino pins and ATmega168 ports. 

 

Figure 3.2: Arduino Pro Mini Pin Out 

 

3.2 5V Regulator IC 

 

Voltage sources in a circuit may have fluctuations resulting in not providing fixed 

voltage outputs. A voltage regulator IC maintains the output voltage at a constant 

value. 7805 IC, a member of 78xx series of fixed linear voltage regulators used to 

maintain such fluctuations, is a popular voltage regulator integrated circuit (IC). The 

xx in 78xx indicates the output voltage it provides. 7805 IC provides +5 volts 

regulated power supply with provisions to add a heat sink.  

 

7805 IC Rating: 
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 Input voltage range 7V- 35V  

 Current rating Ic = 1A  

 Output voltage range V.Max=5.2V, V.Min=4.8V 

 

Figure 3.3: 5V Regulator IC 

 
3.3 Ultrasonic Sensor 

 
An ultrasonic sensor is an electronic device that measures the distance of a target 

object by emitting ultrasonic sound waves, and converts the reflected sound into an 

electrical signal. Ultrasonic waves travel faster than the speed of audible sound (i.e. 

the sound that humans can hear). Ultrasonic sensors have two main components: the 

transmitter (which emits the sound using piezoelectric crystals) and the receiver 

(which encounters the sound after it has travelled to and from the target). 
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Figure 3.4: Ultrasonic Sensor 

 

 
HC-SR04 Ultrasonic Sensor - Working 

As shown above the HC-SR04 Ultrasonic (US) sensor is a 4 pin module, whose pin 

names are Vcc, Trigger, Echo and Ground respectively. This sensor is a very popular 

sensor used in many applications where measuring distance or sensing objects are 

required. The module has two eyes like projects in the front which forms the 

Ultrasonic transmitter and Receiver. The sensor works with the simple high school 

formula that 

Distance = Speed × Time 

The Ultrasonic transmitter transmits an ultrasonic wave, this wave travels in air and 

when it gets objected by any material it gets reflected back toward the sensor this 

reflected wave is observed by the Ultrasonic receiver module as shown in the picture 

below- 

 
Figure 3.5: Working of sensor 
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Now, to calculate the distance using the above formulae, we should know the Speed 

and time. Since we are using the Ultrasonic wave we know the universal speed of US 

wave at room conditions which is 330m/s. The circuitry inbuilt on the module will 

calculate the time taken for the US wave to come back and turns on the echo pin high 

for that same particular amount of time, this way we can also know the time taken. 

Now simply calculate the distance using a micro-controller or microprocessor. 

 

 

How to use the HC-SR04 Ultrasonic Sensor 

HC-SR04 distance sensor is commonly used with both micro-controller and 

microprocessor platforms like Arduino, ARM, PIC, Raspberry Pie etc. The following 

guide is universally since it has to be followed irrespective of the type of 

computational device used.Power the Sensor using a regulated +5V through the Vcc 

ad Ground pins of the sensor. The current consumed by the sensor is less than 15mA 

and hence can be directly powered by the on board 5V pins (If available). The Trigger 

and the Echo pins are both I/O pins and hence they can be connected to I/O pins of the 

micro controller. To start the measurement, the trigger pin has to be made high for 

10uS and then turned off. This action will trigger an ultrasonic wave at frequency of 

40Hz from the transmitter and the receiver will wait for the wave to return. Once the 

wave is returned after it getting reflected by any object the Echo pin goes high for a 

particular amount of time which will be equal to the time taken for the wave to return 

back to the sensor.The amount of time during which the Echo pin stays high is 

measured by the MCU/MPU as it gives the information about the time taken for the 

wave to return back to the Sensor. Using this information, the distance is measured as 

explained in the above heading. 

 

Applications 

● Used to avoid and detect obstacles with robots like biped robot, obstacle 

avoider robot, path finding robot etc. 

● Used to measure the distance within a wide range of 2cm to 400cm 

● Can be used to map the objects surrounding the sensor by rotating it 

● Depth of certain places like wells, pits etc can be measured since the waves 

can penetrate through water 
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Ultrasonic Sensor Pin Configuration 

Table 01:  Ultrasonic Sensor Pin Description 

 

Pin 

Number 
Pin Name Description 

1 Vcc The Vcc pin powers the sensor, typically with +5V 

2 Trigger 
Trigger pin is an Input pin. This pin has to be kept high for 

10us to initialize measurement by sending US wave. 

3 Echo 

Echo pin is an Output pin. This pin goes high for a period of 

time which will be equal to the time taken for the US wave 

to return back to the sensor. 

4 Ground This pin is connected to the Ground of the system. 

 

 

HC-SR04 Sensor Features 

● Operating voltage: +5V 

● Theoretical Measuring Distance: 2cm to 450cm 

● Practical Measuring Distance: 2cm to 80cm 

● Accuracy: 3mm 

● Measuring angle covered: <15° 

● Operating Current: <15mA 

● Operating Frequency: 40Hz 

 

3.4 Battery  

 

Ultra-Fire 18650 3.7V 3000mAh Rechargeable Lithium Batteries Without Protection 

has high discharge performance Li-ion Rechargeable Battery. More than 500 charge-

discharge cycles. 
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Figure 3.6: Battery  

Specification:  

 Type: B8630 

 Capacity: 3000mAh 

 Rated Voltage: 3.7V 

 Charge Termination Voltage: 4.2V 

 Discharge Termination Voltage: 2.75V 

 Maximum Charge Current: 6000mAh 

 Maximum Discharge Current: 6000mAh  

 Material: Lithium 

 

 

3.5 DC Gear Motor 

 

Gear motors are mechanisms that adjust the speed of electric motors, leading them to 

operate at a certain speed. They are composed of a series of gears that make up a 

kinematic chain, working on a set of rotary parts. Their main purpose is to allow 

the reduction from an initial high speed to a lower one without negatively affecting 
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the mechanism. In addition to this adjustment, a gear motor is in charge of adjusting 

the mechanical power of a system.  

 

 

 

 

 

 

Figure 3.7: Gear Motor 

Mechanical components that complement gear motors 

Gear motors are composed of an electric motor and gears, which form the kinematic 

chain – the fundamental component of the gear ratio. 

Kinematic chain 

A motor’s speed reducer is composed of a speed reducer and its gears.  This speed 

reducer is basically a variable speed drive that allows for the speed to be reduced and 

increased at the output shaft. 

Gears 

Gears are toothed wheels made of metal or plastic (and new materials with each 

passing day) that transmit motion when meshing with each other.  They are defined by 

their number of teeth and their size. In addition, they may have straight-cut or helical 

teeth.  

Motors 

The five types of motors that see the most use in gear motors are: 



 

 19 

 Brushed motors, with brushes normally made out of carbon. They 

are bidirectional and may be used with DC or AC. They have a service life of 

about 3000 hours. 

 Asynchronous motors, which are brushless single-direction motors. They are 

highly limited. 

 Synchronous brushless motors, which may be single-direction or bidirectional. 

They have a constant speed if the frequency of the power source is stable. 

 Brushless DC motors that use a driver and can attain high speeds. 

 Stepper DC brushless motors. They can be positioned with an average 

precision of 7.5º. 

 

 
3.6 L293D Motor Driver IC 

 

The L293D is a popular 16-Pin Motor Driver IC. As the name suggests it is mainly 

used to drive motors. A single L293D IC is capable of running two DC motors at the 

same time; also the direction of these two motors can be controlled independently. 

 

Figure 3.8: Motor driver IC L293D 
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Working Process 

L293D IC is a typical Motor Driver IC which allows the DC motor to drive on any 

direction. This IC consists of 16-pins which are used to control a set of two DC 

motors instantaneously in any direction. It means, by using a L293D IC we can 

control two DC motors. 

Features 

 Can be used to run Two DC motors with the same IC. 

 Speed and Direction control is possible 

 Motor voltage Vcc2 (Vs): 4.5V to 36V 

 Maximum Peak motor current: 1.2A 

 Maximum Continuous Motor Current: 600mA 

L293D Pin Configuration 

Table 02: Motor Driver Pin out 

Pin Number Pin Name Description 

1 Enable 1,2 
This pin enables the input pin Input 1(2) and 

Input 2(7) 

2 Input 1 
Directly controls the Output 1 pin. Controlled by 

digital circuits 

3 Output 1 Connected to one end of  Motor 1 

4 Ground 
Ground pins are connected to ground of circuit 

(0V) 

5 Ground 
Ground pins are connected to ground of circuit 

(0V) 

6 Output 2 Connected to another end of  Motor 1 

7 Input 2 
Directly controls the Output 2 pin. Controlled by 

digital circuits 

8 Vcc2 (Vs) 
Connected to Voltage pin for running motors 

(4.5V to 36V) 
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9 Enable 3,4 
This pin enables the input pin Input 3(10) and 

Input 4(15) 

10 Input 3 
Directly controls the Output 3 pin. Controlled by 

digital circuits 

11 Output 3 Connected to one end of Motor 2 

12 Ground 
Ground pins are connected to ground of circuit 

(0V) 

13 Ground 
Ground pins are connected to ground of circuit 

(0V) 

14 Output 4 Connected to another end of Motor 2 

 

Use of a L293D Motor Driver IC 

Using this L293D motor driver IC is very simple. The IC works on the principle of 

Half H-Bridge, let us not go too deep into what H-Bridge means, but for now just 

know that H bridge is a set up which is used to run motors both in clock wise and anti 

clockwise direction. As said earlier this IC is capable of running two motors at the any 

direction at the same time, the circuit to achieve the same is shown below. 

 

Figure 3.9: L293D circuit Diagram 
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All the Ground pins should be grounded. There are two power pins for this IC, one is 

the Vss(Vcc1) which provides the voltage for the IC to work, this must be connected 

to +5V. The other is Vs(Vcc2) which provides voltage for the motors to run, based on 

the specification of your motor you can connect this pin to anywhere between 4.5V to 

36V, here I have connected to +12V. 

The Enable pins (Enable 1,2 and Enable  3,4)  are used to Enable Input pins for Motor 

1 and Motor 2 respectively. Since in most cases we will be using both the motors both 

the pins are held high by default by connecting to +5V supply. The input pins Input 

1,2 are used to control the motor 1 and Input pins 3,4 are used to control the Motor 2. 

The input pins are connected to the any Digital circuit or micro-controller to control 

the speed and direction of the motor. 

 

Applications 

 Used to drive high current Motors using Digital Circuits 

 Can be used to drive Stepper motors 

 High current LED’s can be driven 

 Relay Driver module (Latching Relay is possible) 

 

3.7 Buzzer 

Audio signal device that can be music, electromechanical or piezoelectric (short 

piano). Typical uses of sound and beep include user authentication, such as alarms, 

timers, mouse clicks, or stairs. When the force is applied, the current passes through 

the wire coil inside the coil that emits the magnetic field. Shaking the signal through 

the coil, the noise emits a variable magnetic field that vibrates the disc. This 

movement makes a resounding noise. 

Specifications 

 Working Voltage: 1.0 ~ 20.0V 

 Rated Voltage: 3.0V 

 Diameter: Ø12.5mm 

 Overall View: 6.3mm 
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 Sleep: 15,000pF 

 Current Use: ≤2mA 

 Resonance Frequency: 4,000Hz 

 Voice Pressure Level at 10cm: ≥75db 

 Self-driving: No 

 

 

Figure 3.10: Buzzer 

 

3.8 The Smoothing Capacitor 

 

When there is a potential difference across the conductors (e.g., when a capacitor is 

attached across a battery), an electric field develops across the dielectric, causing 

positive charge (+Q) to collect on one plate and negative charge (-Q) to collect on the 

other plate. If a battery has been attached to a capacitor for a sufficient amount of 

time, no current can flow through the capacitor. However, if an accelerating or 

alternating voltage is applied across the leads of the capacitor, a displacement current 

can flow. 

 

Figure 3.11: Capacitor 



 

 24 

An ideal capacitor is characterized by a single constant value for its capacitance. 

Capacitance is expressed as the ratio of the electric charge (Q) on each conductor to 

the potential Difference (V). The SI unit of capacitance is the farad (F), which is equal 

to one coulomb per volt (1 C/V). Typical capacitance values range from about 1 pF 

(10−12 F) to about 1 mF (10−3 F). The capacitance is greater when there is a 

narrower separation between conductors and when the conductors have a larger 

surface area. 

In practice, the dielectric between the plates passes a small amount of leakage current 

and also has an electric field strength limit, known as the breakdown voltage. The 

conductors and leads introduce an undesired inductance and resistance. Capacitors are 

widely used in electronic circuits for blocking direct current while allowing 

alternating current to pass. In analog filter networks, they smooth the output of power 

supplies. In resonant circuits they tune radios to particular frequencies. In electric 

power transmission systems, they stabilize voltage and power flow. 

 

Figure 3.12: The Smoothing Capacitor with Full Bridge Rectifier 

 

The full-wave bridge rectifier however, gives us a greater mean DC value (0.637 

Vmax) with less superimposed ripple while the output waveform is twice that of the 

frequency of the input supply frequency. We can improve the average DC output of 

the rectifier while at the same time reducing the AC variation of the rectified output 
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by using smoothing capacitors to filter the output waveform. Smoothing or reservoir 

capacitors connected in parallel with the load across the output of the full wave bridge 

rectifier circuit increases the average DC output level even higher as the capacitor acts 

like a storage device as shown below. Too low a capacitance value and the capacitor 

has little effect on the output waveform. But if the smoothing capacitor is sufficiently 

large enough (parallel capacitors can be used) and the load current is not too large, the 

output voltage will be almost as smooth as pure DC.  

 

 
3.9 Resistor 

 
A resistor is a passive two-terminal electrical component that implements electrical 

resistance as a circuit element. Resistors act to reduce current flow, and, at the 

sometime, act to lower voltage levels within circuits. Resistors may have fixed 

resistances or variable resistances, such as those founding thermostats, visitors, 

trimmers, photo resistors, hamsters and potentiometers. The current through a resistor 

is in direct proportion to the voltage across the resistor's terminals. This relationship is 

represented by Ohm's law. 

 

 

 

Figure 3.13: Resistor 

 

 

Theory of operation: 

 

The behavior of an ideal resistor is dictated by the relationship specified by  

Ohm’s  law: 

V = I.R 

Ohm's law states that the voltage (V) across a resistor is proportional to the current 

(I), where the constant of proportionality is the resistance (R). 
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Equivalently, Ohm's law can be stated: 

I = V/R 

This formulation states that the current (I) is proportional to the voltage (V) and 

inversely proportional to the resistance (R). This is directly used in practical 

computations. For example, if a 300 ohm resistor is attached across the terminals of 

a12 volt battery, then a current of12 / 300 = 0.04 amperes flows through that resistor. 

 

3.10 Arduino IDE 

 

The digital microcontroller unit named as Arduino Nano can be programmed with the 

Arduino software IDE. There is no any requirement for installing other software 

rather than Arduino. Firstly, Select "Arduino Nano from the Tools, Board menu 

(according to the microcontroller on our board). The IC used named as ATmega328 

on the Arduino Nano comes pre burned with a boot loader that allows us to upload 

new code to it without the use of an external hardware programmer. Communication 

is using the original STK500 protocol (reference, C header files). We can also bypass 

the boot loader and programs the microcontroller through the ICSP (In Circuit Serial 

Programming) header. The ATmega16U2 (or 8U2 in the rev1 and rev2 boards) 

firmware source code is available. The ATmega16U2/8U2 is loaded with a DFU boot 

loader, which can be activated by: 

On Rev1 boards: connecting the solder jumper on the back of the board (near the map 

of Italy) and then resetting the 8U2. On Rev2 or later boards: there is a resistor that 

pulling the 8U2/16U2 HWB line to ground, making it easier to put into DFU 

mode.The Arduino Nano is one of the latest digital microcontroller units and has a 

number of facilities for communicating with a computer, another Arduino, or other 

microcontrollers. The ATmega328 provides UART TTL at (5V) with serial 

communication, which is available on digital pins 0 -(RX) for receive the data and pin 

no.1 (TX) for transmit the data. An ATmega16U2 on the board channels this serial 

communication over USB and appears as a virtual com port to software on the 

computer. The '16U2 firmware uses the standard USB COM drivers, and no external 

driver is needed. However, on Windows, an .in file is required. The Arduino software 

includes a serial monitor which allows simple textual data to be sent to and from the 

Arduino board. 
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The RX and TX LEDs on the board will flash when data is being transmitted via the 

USB-to-serial chip and USB connection to the computer (but not for serial 

Communication on pins 0 and 1). A Software Serial library allows for serial 

communication on any of the Nano's digital pins. The ATmega328 also supports I2C 

(TWI) and SPI communication. 

 

Figure 3.14: Arduino Software Interface IDE 

 

 The Arduino software includes a Wire library to simplify use of the I2C bus. Arduino 

programs are written in C or C++ and the program code written for Arduino is called 

sketch. The Arduino IDE uses the GNU tool chain and AVR Lab to compile 

programs, and for uploading the programs it uses argued. As the Arduino platform 

uses Atmel micro-controllers, Atmel's development environment, AVR Studio or the 

newer Atmel Studio, may also be used to develop software for the Arduino. The 

Arduino Integrated Development Environment - or Arduino Software (IDE) - contains 

a text editor for writing code, a message area, a text console, a toolbar with buttons for 

common functions and a series of menus. It connects to the Arduino and Genuino 

hardware to upload programs and communicate with them. 
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Writing Sketches 

Programs written using Arduino Software (IDE) are called sketches. These sketches 

are written in the text editor and are saved with the file extension .ino. The editor has 

features for cutting/pasting and for searching/replacing text. The message area gives 

feedback while saving and exporting and also displays errors. The console displays 

text output by the Arduino Software (IDE), including complete error messages and 

other information. The bottom right hand corner of the window displays the 

configured board and serial port. The toolbar buttons allow you to verify and upload 

programs, create, open, and save sketches, and open the serial monitor. 

Sketchbook 

The Arduino Software (IDE) uses the concept of a sketchbook: a standard place to 

store your programs (or sketches). The sketches in your sketchbook can be opened 

from the File > Sketchbook menu or from the Open button on the toolbar. The first 

time you run the Arduino software, it will automatically create a directory for your 

sketchbook. You can view or change the location of the sketchbook location from 

with the Preferences dialog. Beginning with version 1.0, files are saved with a .ino file 

extension. Previous versions use the .pde extension. You may still open .pde named 

files in version 1.0 and later, the software will automatically rename the extension to 

.ino. 

Tabs, Multiple Files, and Compilation 

Allows you to manage sketches with more than one file (each of which appears in its 

own tab). These can be normal Arduino code files (no visible extension), C files (.c 

extension), C++ files (.cpp), or header files (.h). 

 

Uploading 

Before uploading your sketch, you need to select the correct items from the Tools > 

Board and Tools > Port menus. The boards are described below. On the Mac, the 

serial port is probably something like /dev/tty.usbmodem241 (for a Uno or Mega2560 
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or Leonardo) or /dev/tty.usbserial-1B1 (for a Duemilanove or earlier USB board), or 

/dev/tty.USA19QW1b1P1.1 (for a serial board connected with a Keyspan USB-to-

Serial adapter). On Windows, it's probably COM1 or COM2 (for a serial board) or 

COM4, COM5, COM7, or higher (for a USB board) - to find out, you look for USB 

serial device in the ports section of the Windows Device Manager. On Linux, it 

should be /dev/ttyACMx , /dev/ttyUSBx or similar. Once you've selected the correct 

serial port and board, press the upload button in the toolbar or select the Upload item 

from the Sketch menu. Current Arduino boards will reset automatically and begin the 

upload. With older boards (pre-Diecimila) that lack auto-reset, you'll need to press the 

reset button on the board just before starting the upload. On most boards, you'll see 

the RX and TX LEDs blink as the sketch is uploaded. The Arduino Software (IDE) 

will display a message when the upload is complete, or show an error. 

When you upload a sketch, you're using the Arduino Bootloader, a small program that 

has been loaded on to the microcontroller on your board. It allows you to upload code 

without using any additional hardware. The Bootloader is active for a few seconds 

when the board resets; then it starts whichever sketch was most recently uploaded to 

the microcontroller. The Bootloader will blink the on-board (pin 13) LED when it 

starts (i.e. when the board resets). 

Libraries 

Libraries provide extra functionality for use in sketches, e.g. working with hardware 

or manipulating data. To use a library in a sketch, select it from the Sketch > Import 

Library menu. This will insert one or more #include statements at the top of the sketch 

and compile the library with your sketch. Because libraries are uploaded to the board 

with your sketch, they increase the amount of space it takes up. If a sketch no longer 

needs a library, simply delete its #include statements from the top of your code. There 

is a list of libraries in the reference. Some libraries are included with the Arduino 

software. Others can be downloaded from a variety of sources or through the Library 

Manager. Starting with version 1.0.5 of the IDE, you do can import a library from a 

zip file and use it in an open sketch. See these instructions for installing a third-party 

library. 
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Third-Party Hardware 

Support for third-party hardware can be added to the hardware directory of your 

sketchbook directory. Platforms installed there may include board definitions (which 

appear in the board menu), core libraries, Bootloaders, and programmer definitions. 

To install, create the hardware directory, then unzip the third-party platform into its 

own sub-directory. (Don't use "Arduino" as the sub-directory name or you'll override 

the built-in Arduino platform.) To uninstall, simply delete its directory.  

Serial Monitor 

This displays serial sent from the Arduino or Genuino board over USB or serial 

connector. To send data to the board, enter text and click on the "send" button or press 

enter. Choose the baud rate from the drop-down menu that matches the rate passed to 

Serial begin in your sketch. Note that on Windows, Mac or Linux the board will reset 

(it will rerun your sketch) when you connect with the serial monitor. 

 

3.11  Proteus Software 

The Proteus Design Suite is a proprietary software tool suite used primarily for 

electronic design automation. The software is used mainly by electronics design 

engineers and technicians to create schematics and electronics prints for 

manufacturing printed circuit boards. The first version of what is now the Proteus 

Design Suite was called PC-B and was written by the company chairman, John 

Jameson, for DOS in 1988. Schematic Capture support followed in 1990 with a port to 

the Windows environment shortly thereafter. Mixed mode SPICE Simulation was first 

integrated into Proteus in 1996 and micro-controller simulation then arrived in Proteus 

in 1998. Shape based auto routing was added in 2002 and 2006 saw another major 

product update with 3D Board Visualization. More recently, a dedicated IDE for 

simulation was added in 2011 and MCAD import/export was included in 2015. 

Support for high speed design was added in 2017. Feature led product releases are 

typically biannual, while maintenance-based service packs are released as required.  
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Figure 3.15: Proteus Software Interface 
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Chapter 4 

 

Methodology 

 

 

 
4.1 Our methodologies for the project 

 Creating an idea for the design and construction of  Construction and 

Performance Test of an Automatic Collision Avoidance Vehicle to 

Prevent Accident . And designing a block diagram to know which 

components we need to construct it.  

 Collecting all the components for our desired system. 

 Setting up all the components in a system. Then assembling all the 

blocks in a system and finally running the system to check if it actually 

works or not. 

 

4.2 Working Principle 

 

We are taking main power from the  battery of this system. Here we used the Arduino 

Pro Mini micro-controller to make the car work automatically. We also used here 

Ultrasonic sensors, Motor drivers, voltage regulators, Gear motors etc. Vehicle is 

controlled automatically without any manual operation when the vehicle is at 50cm 

distance away from the front vehicle. When the car come closer to an obstacle then it 

will reduce its speed 50cm to 30cm distance, if obstacle don’t move in-front of the car 

then our vehicle will stop automatically before being hit. This is the main purpose of 

our system. 

 

 

Programming Code: 

#include <LiquidCrystal_I2C.h> 

LiquidCrystal_I2C lcd(0x27 ,16,2); 

 

int buzzar = A0; 
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#define trigPin 2 

#define echoPin 4 

long duration; 

long distance; 

int motor1 = 3; 

int motor2 = 5; 

 

int motor3 = 6; 

int motor4 = 9; 

 

 

 void setup() { 

Serial.begin (9600); 

 

  pinMode(motor1,OUTPUT); 

   pinMode(motor2,OUTPUT); 

    pinMode(motor3,OUTPUT); 

     pinMode(motor4,OUTPUT); 

      pinMode(buzzar, OUTPUT); 

      pinMode(trigPin, OUTPUT); 

       pinMode(echoPin, INPUT); 

        

  delay(100); 

} 

void(* resetFunc) (void) = 0; //declare reset function @ add 

void loop() { 

  digitalWrite(trigPin, LOW); 

  delayMicroseconds(2); 

  digitalWrite(trigPin, HIGH); 

  delayMicroseconds(10); 

  digitalWrite(trigPin, LOW); 

   

  // Measure the response from the HC-SR04 Echo Pin 

   duration = pulseIn(echoPin, HIGH); 
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  distance= duration*0.034/2; 

 

Serial.println(distance); 

  delay(20); 

 forward(); 

  if(distance < 70){ 

  Buzzer(); 

  } 

 

  if(distance < 50){ 

  slow(); 

  } 

    if(distance < 20){ 

  Stop(); 

  } 

delay(200); 

} 

 

void forward() 

{ 

            analogWrite(motor1, 255); 

            digitalWrite(motor2, LOW); 

            analogWrite(motor3, 255); 

            digitalWrite(motor4, LOW); 

 

} 

 

void slow() 

{ 

            analogWrite(motor1, 130); 

            digitalWrite(motor2, LOW); 

            analogWrite(motor3, 130); 

            digitalWrite(motor4, LOW); 

 

} 
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void backward() 

{ 

            digitalWrite(motor1, LOW); 

            analogWrite(motor2, 255); 

            digitalWrite(motor3, LOW); 

            analogWrite(motor4, 255); 

} 

void right() 

{ 

            digitalWrite(motor1, LOW); 

            analogWrite(motor2, 255); 

            analogWrite(motor3, 255); 

            digitalWrite(motor4, LOW); 

} 

 

void left() 

{ 

            analogWrite(motor1, 255); 

            digitalWrite(motor2, LOW); 

            digitalWrite(motor3, LOW); 

            analogWrite(motor4, 255); 

} 

void Stop() 

{ 

            digitalWrite(motor1, LOW); 

            digitalWrite(motor2, LOW); 

            digitalWrite(motor3, LOW); 

            digitalWrite(motor4, LOW); 

} 
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4.3 Our Final System View 

 

 

Figure 4.1: Our Final System (Front View) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4.2: Our Final System (Top View) 
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Chapter 5 

 

Result and Discussion 

 

 

 

5.1 Discussion 

 

While working on our project, we did face some difficulties as it is a very complex 

system but the end results, we came up with were quite satisfactory. We have put the 

whole system through several tasks to validate our work and also have taken 

necessary notes for future improvements. Some future recommendations that we have 

involves improvement in system design and wiring, adding features for more efficient.  

 

5.2 Result 

 

After making our project we observe it very careful. It works as we desire. Our project 

give output perfectly and all equipment are work perfectly. We check how much it 

works and we get perfect output from this project.  

 Finally, we have completed our project successfully & check our project its 

run accurately according to our objective. 

 When the vehicle detect the object at less than 70cm, buzzer will be ring and 

alert to user. 

 The vehicle was moved and when find some obstacle towards of this robot. 

And  reduce its speed 50cm to 30cm. 

 If the obstacle don’t move then our system will fully stop before being hit. 
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Figure no 5.1: 1st Result Outcome 

Figure no 5.2: 2nd Result Outcome 

Figure no 5.3: 3rd Result Outcome 
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5.3 Advantage 

 

There are certainly many advantages of our project and some of the major ones have 

been given below: 

• Able to measure the distance obstacle from car. 

• The whole system is automatic system. 

• The system is user friendly. 

• Able to detect object / obstacle. 

 

5.4 Application 

 

The application areas for this project in this modern and practical world are huge and 

some of these are given below:  

• To use in various vehicle like privet car,  truck, bus etc. 
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Chapter 6 

 

Conclusion 

 

 

 

6.1 Conclusion 

 

This automatic vehicles accident avoidance system can be an important aid in 

constructing smart transport systems in Bangladesh in near future. The main goal of 

this system is to reduce the accidents by controlling vehicle speed. This smart system 

will make vehicles more secure, trustworthy, and effective to owners and passengers. 

It will contribute to saving people's lives.  

 

6.2 Future Scope 

 

We are thinking about adding many features to our project in the future to get more 

desirable out comes. Some of the steps that we are thinking about taking are given 

below: 

 In future, we are thinking about adding a camera feature for show the obstacle 

image on screen. 

 In future we will improve avoidance feature.  

 In future we are thinking about adding more feature to detect various data 

from unnecessary incident.  
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